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GETTING STARTED

IT's THE Business You WAaNT, Not THE CARDS!I®

Cardiris is the unbeatable productivity tool for your business cards. This busi-
ness card organizer allows you to archive, index and OCR business cards
from around the world.

In our information age, all key corporate information is contained in data-
bases. With information being the key, Cardiris gives a comprehensive answer to
the need to manage your business contacts: Cardiris goes the full circle from
archiving scanned business cards to contact management. After all, isn’t it the
business you want, and not the cards?

ONE, CARDIRIS GIVES You GREAT IMAGES

Cardiris improves the everyday operation of your office by getting rid of all
business cards. Enter any office and you’ll find the desk and drawers of the
employees crowded with business cards of all types and places. Business cards
suffer more than other documents from the known disadvantages of the paper
world: they get lost easily, aren’t available to your colleagues, can’t be searched
or sorted etc.

Cardiris, the “electronic Rolodex™®, puts a final end to all this. You begin by
scanning the business cards, thus putting images in a database. Use this manage-
ment tool to file your business cards and no more stacks of business cards will be
lying around in your office!

So, all business cards can be thrown away or returned to the owner as soon as
they have been archived. This means that you never lose any information con-
tained on a card, not even the company’s colorful logo or slogan, the contact’s
photograph or still a second telephone number or e-mail address which you don’t
usually encode in your “traditional” contact manager or database.

When you are dealing with “exotic” business cards - in, say, Vietnamese or
Arabic - which you simply cannot enter in a database, the advantage is all the
more prominent: as you first archive the card images, Cardiris offers a unique
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solution here. Even if a business card can’t be read by OCR, the color image is
there to be consulted!

As a wide range of dedicated business card scanners, flatbed scanners and
“all-in-one™ devices or “MFPs” (“multifunctional peripherals™) is supported, what-
ever scanner you may already own is fine by us.

Your Cardiris software may be bundled with a business card scanner. Dedi-
cated business card scanners are optimized for scanning business cards and have
many advantages over other scanner types: they hardly take up any space on
your desk, swiftly cope with calling cards of varying paper and printing qualities
and you never have to wonder about selecting the correct card format.

The images are saved compressed to limit the use of space on your hard disk.
The scanned business cards are prominently displayed so as to make them legible
without having to zoom. Optimal legibility is ensured, even on low-end 14" moni-
tors and the LCD screens of notebook computers!

As Cardiris also allows you to add comments, it suffices to scan every busi-
ness card you come across and add some notes and you’ll never lose any infor-
mation again!

Two, OCR BRINGS You EDiTABLE TEXT

Once the cards are archived, you can convert images into data by indexing
and OCRing them. Indexing means that a business card is sorted by a primary
search key - the company name is filled out and checked -, OCR means that the
card’s data is extracted automatically from the image.

OCR stands for two things here: character recognition to convert the
scanned image into editable text and field analysis. Optical character recognition
(OCR) allows to encode business cards without the time-consuming task of re-
typing them. Think of your last exhibition when you came back with an entire
stack of business cards and it took your secretary two days to encode them!

Cardiris incorporates specialized recognition technology, optimized for tiny
characters, and supports up to 49 countries! The major countries of all conti-
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nents are supported: North and South American business cards and business
cards from the European countries, including the Eastern-European nations.

Field analysisassigns the recognized data to specific database fields. Cardiris
extensively uses a knowledge database, thus acquiring the necessary intelligence
to discriminate the first and last name, a city and its state, a telephone and a fax
number etc.

At this stage, Cardiris takes the layout of a business card into account. Each
country has a different “style” of composing business cards, Americans com-
pose an address differently than the French do etc. In this way, Cardiris can
process correctly business cards of all designs and countries: business cards with
an American or European look, vertical cards as well as horizontal cards etc.

When a country is not supported, you can draw a frame around the informa-
tion and drag the frame to a database ficld - say, the city: the OCR gets done “on
the fly”.

The recognition accuracy depends on the printing quality, whether or not a too
stylized font or “exotic” layout has been used etc. Cutting and pasting is available
to edit and correct the recognized data, but so are “drag-and-drop” operations
for maximal ease of use.

Interestingly, the scanning, indexing and recognition are separate phases. In-
dexing and OCR can be deferred, performed later on at any moment. Sales
executives at an info desk or on the company booth at a trade show, secretaries
at a reception desk may be too busy to perform the complete cycle of indexing
and OCRing business cards, but surely they can quickly scan the business card of
their visitors... When they do, Cardiris will keep trace of every single contact
they come across with a minimal effort.

THREE, |T's A DATABASE

Once your business cards are converted into text placed in data fields, you
have a real address database, similar to a cardfile system: the data is directly
searchable by any field. Looking up a company, client or prospect is a cinch.
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Even with very little to go on, say, no more than the first characters of a company
name, you are sure to find your contact again instantly.

The resulting data is available for export. Cardiris smoothly complements
such applications as contact managers, “personal information managers” (“PIMs™),
general databases or even word processors whose mail merge function allows to
print letters, envelopes and labels. Or synchronize your Cardiris database with
the contacts stored on your PDA - your Palm organizer, your Pocket PC handheld
device etc.

Some other clearcut advantages of Cardiris over the paper world are all too
obvious: as you are dealing with a database, the information is centralized and
available to all your colleagues. Also, databases are easily transportable on CD-
ROM etc.

ABouT THIS GUIDE

This guide gives a short introduction to Cardiris. It contains all you need to
know to get started with this I.R.I.S. product successfully.

However, this guide does not intend to be a complete user documentation of
Cardiris. To make full use of the many advanced capabilities of this software
package, it is mandatory that you study the on-line help information closely.

SysTEM REQUIREMENTS

This is the minimal system configuration required to use Cardiris:

U a Pentium based Intel PC or compatible.

U 64 MB RAM.

U 85 MB free disk space.

U the Windows XP, Windows ME, Windows 2000 or Windows 98 operat-

ing system.

Your Cardiris software may be bundled with a business card scanner. It takes

a USB port to connect this scanner.
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INSTALLING THE CARDIRIS SOFTWARE

The Cardiris software is delivered exclusively on an autorunning CD-ROM.
To install, simply insert the CD-ROM in your CD-ROM drive and wait for the
installation program to start running. Follow the on-screen instructions.

REGISTER TO VOTE!

Don’t forget to register your Cardiris licence! Doing so will allow us to keep
you informed of future product developments and related I.R.I.S. products. The
registration benefits, including free product support and special offers, are strictly
limited to registered users.



E? Cardiris Help

e AN
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Head Office (Belgium)

Phone: 32-10-45 13 64

Reference Information Fau: 32-10-45 24 43
Product Options

Product Registration
Product Support

I.R.I.5. on the Internet

V)] LR.LS. o Home page: http: /i irislink.cam
@ Register your Cardiris licence Cardiris web site: bttpe/fwewew .cardiris .com
2] cardiris reqgistration form On-line shop: http: ffshop.irislink.com
[i] How ta get praduct support E-mail info: info@irislink.com
h:j Getting product suppart by e-mail E-mail sales: sales@irislink.com

E-mail support: supportdirislink.com,
support@irisusa.com

get in touch w
ﬁ Getting in touch with LR.I.S. by e-mail
43 I.R.1.S. on the Internet

usa Office

Phone: 1-561-921-0847 / 800-447-4744
Fax: 1-361-921-0854

France Office

Phone: 0810-00 19 27

You can register in many ways: by sending in your registration card or faxing
its electronic counterpart, by calling .R.I.S. during working hours and by filling
out a registration form on the I.R.1.S. home page!
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STARTING THE SOFTWARE UP

Click on the Cardiris application in the submenu "I.R.I.S. Applications - Cardiris"
or click on the shortcut to the Cardiris application on your desktop.

f I1.R.I5. applications » B Cardiis ¥ | &' Cardiis
IRISPen »
Readitis ¥

@ L.R.L5. on the Internet
ﬁ Uninstall Cardiris
'@ User's Manual

IT TAKES Two TO TANGO

The Cardiris application window is displayed. Use the command "Open" un-
der the "File" menu and load the sample database SAMPLE.DAT. (You can
access the databases last loaded directly under the "File" menu.)

= Cardiris
File Edit Settings Register He

D

alelclo]

Mew. .,

e

1 sample

Exik

Cardiris starts up in the card album view mode: it displays eight business
cards in an album-like presentation. Only the major data fields - company name,
first name and name, job title and e-mail address - are listed.



&1 Cardirjs - [sample] |L‘|E|E|
Fle Edt Settings Card WYiew Process Register Help

d 4« » P &= = | @A e W [iedstates -] =

B8 A | «lululelolelelelulelalelvlmlnlelelalelsivlolvlulxlviz]

il il

HOWARD Kb

- . BCOM

LEXMARK |

m .Wmerica Inc.
- uratec r

Tha P Spmcint

g

Falph ©. Bauer

ol-s| SII .' Seiko Instruments USA Ing m}rumentsusnlnc.

Maksuo Kirk,
Product Manager

kirk, matsuo@seikosi com

For Help, press F1 1/9 UM

A color code indicates the card status of each business card: new cards are
yellow, indexed cards are green and verified cards are blue. The card status is a
crucial concept and we’ll discuss it in depth later.

Click the arrow buttons below to navigate through the business cards: you’ll
turn the pages of the album.

Double-click a card to open the card view mode (or click the "Card" button
on the Cardiris toolbar). The card view is limited to a single business card. It
displays the card image, the card data or business contact, and the personal notes
and additional information. Click the browse buttons to navigate through the busi-
ness cards.
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=1 Cardiris - [sample]

File Edit Settings Card Yiew Process Register Help

4 D .@ = oeEm em g & o [United states v] =

|18 88 | «alelclolelelalnl ol el lmlin]olelolrlslmlolvlwlwlvlz]

*|| Cormpany
|| First narme:
w 1 Last name
SDSA
Title

HOWARD Kim

izt

Address

City ZIP code
State Country

) || Phone __..J

Fax

Cell phone
E-mail

Web site

Created 11032003 9:33:49
Modified  28/04/2003 &:11:26

Motes [Extra | I (Rl

Press F1 for help [allcards 3oj4s | WM |

Maximize the Cardiris application in both view modes to display the card
image(s) optimally!

A SHORT TUTORIAL

The best way to become familiar with the operation of Cardiris is undoubtedly
by using it. A sample database is provided with the software; it allows you to get



started even when the scanner isn’t connected to your computer yet. Let’s make
use of it now.

Go to the first card of the sample database in the card view. You can sece its
image and the empty data fields - company name, address, phone and fax num-
ber etc. There’s ample room for comments below the image in the "Notes" tab.

=2 Cardiris - [sample] ['L”'E”E
File Edit Settings Card “iew Process Register Help

A4 » DB = == H || ez o [Onited states - =

| B @ | | ajslc]olelelalnli]klumlnlolr olelslalule [wlsly 2]

Company

SII .. Seiko Instruments USA Inc. || First name

Last name

Mike Del Vecchio T

Direcior, Sales and Markeling
Business & Home/Office

1130 Ringwood Court Address
San Josa, California 95131
Phene: (408) 922-5971
Fax: (408) 433-3261 City ZIP code
E-mail mike delvecchio@seikos com
Web Site: www.seikosmart com Skate Country
Fhone
1| 8 g = S| ¥ Phone 2
Q| ] @ 0= sl
Fax
Cell phane
E-mail
Web site

Created  |14/04/2003 16:24:50
el B

Motes | Extra
Press F1 for help lallcards  jzs | o |

Select the correct country with the "Card Style" button.
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## |United states ~| ==

Marway £
1 |1 [Paland

=——{Portugal ]

Fomania

Russia

Serbia

Slow akia

Slavenia

Soukh Africa

Sauth Kaorea

South Korea (English)

Spain

Sweden

Switzerland

Taiwan (English)

Turkesy

Ikraine

Inited Kingdom

Uni

Special routines are used that allow the software to assign the recognized data
to specific database fields - company name, e-mail address and web site etc.
When Cardiris recognizes the character string "John Williams", it “knows” that
John is a first name and Williams a last name. In the same way so does the

system recognize titles, such as "vice president”, "engineer", cities such as Boise
and Chicago, states such as Oregon and Maryland etc.

By selecting the business card’s “style” in the button bar, you not only indicate
the language of the text to be recognized, you also indicate the general layout of
the business card. Each country has a different style of composing business cards,
Americans compose an address differently than the French do etc. (Some card
styles correspond to several languages: Belgium and Canada have two official
languages, Switzerland has three! Cardiris detects the selected language auto-
matically...)
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=
La Référence Logicielle
(’B) Helen Thomas Stéphan Mallavergne
' Coordinateur Technique

Recognition Systems  international Sales

(408) 341-4100

(408) 341-4101 Fax

(408) 341-4135 Direct

= helen_thomas@irco.com 10 rue Vercingétorix

TRy r e 75680 Paris cedex 14
Campbell, CA 95008 USA Tel 01.56.54.80.22
www.handreader.com Fax 01.56.54.80.01

E-mail : smallavergne@apacabar.fr
Web : http://www.apacabar.fr

Click the "Recognize" button to start the character recognition.

The image is converted into editable text, and the recognized text is assigned
to the various fields: the company name gets placed in the company field, the
phone number goes where it belongs etc. You can click the e-mail address and
the URL in the data fields to start your e-mail software and visit your contact’s
web site promptly!
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Company  Seiko Instruments USA Inc.
First name  Kirk %,
Last name Maksua
Title Product Manager Business & Home/OFfice Products Division
Address 1130 Ringwood Court
Cify San Jose ZIPcode 95131
Skate A Counkry LS4
Phone 4058 4333210 =
Phone 2
Fax 408 4333261
Cell phone
E-mail kjrk.matsuo@seikosj.ci%
Web site v, seikosmart, com

=
Created  |11)03/2003 9:33:49
Madified  [1j04/2003 16:03:59

Check the results so far. Use cutting and pasting or drag-and-drop opera-
tions to move data about - you then hold the left mouse button depressed in a field
and drag the text to another field. (The command "Clear All Fields but Notes"
under the "Edit" menu erases all data simultaneously with the exception of the
personal notes you enter manually on via the keyboard.)
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First name  Kirk ¥,

Company  Seiko Instruments USA Inc.

Last name Matsuo

Title Product Manager Business & Horne ) 15 == sisls 1= e ] le g}

3,

o
| Address 1130 RingwuolaJCUurt

Click the status button "V(erified)" to indicate that the card is verified. The
card statusis a crucial concept of Cardiris, and you should understand its meaning
fully before you start using the business card organizer extensively.

=l

Created
Maodified

11/03/2003 9:33:49
1/04/2003 16:03:59

all cards

2l23 LM

When a new card has been scanned, the card’s image is displayed but the
contact’s data aren’t filled out yet. With indexed cards, the company name is
checked by the user; these cards are searchable by the company name.

With verified cards, every field is validated by the user; these contacts can
be searched by any field, exported to other applications, the e-mail address, tele-
phone and fax number can be used without any risk etc.

A color codeis used to distinguish the various card statuses: new cards are
yellow, indexed cards are green and verified cards are blue!

[ [T

|
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CoONSULTING THE CONTACTS

You now have a validated, verified contact in your database! Such addresses
can be consulted, searched, exported... you name it!

Let’s start with some search capabilitics. How can you find your contacts
back? First of all, you can limit the view to cards with a specific card status by
clicking one of the status selection buttons on the Cardiris toolbar. (Click the
button "All Cards" to display the business cards of any status.)

& e e

The status bar indicates which selection is currently enabled (and how many
cards your selection holds). The album view can also be a good indicator that
you’ve enabled a limited view mode because you’ll only see a single color!

Werified cards 1123 LM I

Letter buttons narrow the card selection down further: click a "Letter" but-
ton and you’ll only display the cards (of the selected card status, if any) that start
with that letter.

£ Cardiris - [sample]

File Edit Settings Card Wiew Help Fgf
4> > Ea e
|88 2 | wiaislelolelEc

In this example, we limit the display to the verified cards and refine the selec-
tion further by concentrating on the cards that start with an "S". (Click the wildcard
button "*" to cancel the letter selection.)



SEARCHING CONTACTS

By executing such operations, youre basically using Cardiris as a Rolodex.
But there’s a more advanced way of searching business cards: “free-text” search-
ing!

Use the "Search" field to execute “free-text” searches on all fields simul-
taneously. (Case differences are ignored.) Press Enter to execute the search.

alnf &

When no cards meet the search criteria, you’ll quickly notice it: the application
window is empty and the status bar confirms that there are no cards to display.

# Cardiris - [sample]

Fil= Edit Settings Card “iew Process Register Help

4 « > P & @ a9 §|w &5 4 |united States -] =

B S| «|alslclolelelalnlalslxlcmnlolelolrls|tlulvlwlslv]z]

00 RaLIrA I

ExrPorTING CONTACTS

Obviously, your contacts are available for export. You can for instance save
your contacts in the vCard format and enter them in your Windows Address
Book with a single click. Or send them directly to your PDA software or your
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contact management software Microsoft Outlook (Express). Business card read-
ing smoothly complements such applications as contact managers, databases or
even word processors whose mail merge function allows to print letters, enve-
lopes and labels!

Business card formats E|

=¥ Cd
FrontRange
HTHL [* htrmil)
IEM Lotuz Motes
icrozoft Olutlook,
Micrazaft Outloak Express
Palm Dezktop
Symantec ACT! 2000
Teut [* cav]
wCard [*.vch)

Configure... | Euport | Cloze

1K
Al

The text result looks for instance like this when you send the results directly to
Microsoft Outlook (Express).
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k2 Kirk Y. Matsuo - Contact

File Edit Yiew Insert Format Tools  Ackions  Help -
Hsaveandcose [ & 0 * @5 - -9 -

General ] Details ] Activities ] Cettificates ] All Fields ]

g Full Mame... | [kirk . Matsuo Business ﬂ 40843210

Job title: |Pr0duct Manager Business & Horm Home ﬂ

Compary: |Seiko Instruments USA Inc, Business Fax ﬂ 408 4333261

File as: |Matsu0, Kirk. ¥, j Mobile ﬂ

Address... 1130 Ringwaod Court % E-rinail ﬂ |kirk. ratsuo@seikos.com @

95131 San Jose, California % i

Business ﬂ Display as: |Kirk W, Matsua (kirk. matsuo@seikosi.com)

jff‘”'. Web page address: |htt vy, seikosmart, com

IV This is the mailing address g

IM address: |

Contacks. ., | Cakeqgaories, .. Private [

But as Cardiris is a comprehensive database in its own right, the buck doesn’t
stop here! You can synchronize an external database (of your handheld com-
puter for instance) and the Cardiris database with equal case.

ScANNING BusiNEss CARDS

We could end our short tutorial here... but we haven’t scanned yet! (Your
Cardiris software may be bundled with a business card scanner.)
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Select the scanner as image source with the command "Scanner" under the
"Settings" menu.

T
_l,lpe_ Config...
Buziness Card Reader

[Uzer Interface)

Scanner

Scanner model... ‘

Rezalution: Format:

400 - Cuzbom -

M (" Black-and-white [ Scan multiple cards

" Grepscale i
+ Colar [ Irvert

(] | Cancel

You must select a scanning resolution of 400 dpi to recognize business cards
successfully!

When you’re using a flatbed scanner, you can scan several business cards
simultaneously on the scanner’s flatbed and have them segmented by the soft-
ware. The background must be black if Cardiris is to extract the various business
cards.
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Annelies Verbeeck
Sales Engineer

Bangue Brusclics Lambert sa

Lotus Development Benelux BV
Excelsiorlaan 61

1930 Zaveniem

Belgium

Tel: +32(0)2-T180911
Fax: +32(0)2- 7254572

Hiris

LDiocument to Knotoledge

Christophe Sauboin
Development Engineer
Retail and Distribution

Enable the option "Scan Multiple Cards" in the scanner setup or select "Mul-
tiple Cards" under the "Settings" menu before you scan the cards! (Select the
option "Single Card" when you’re scanning the business cards one by one.)

* Single card

¥ Scan multiple cards w

The complete page as you scanned it will never appear as such on the com-
puter screen; only the segmented business cards will.

If you forgot to enable the image “splitting” before the scanning, select the
large image and click the command "Extract Card(s)" under the "Process" menu
to segment it into the actual card images, throwing away the superfluous black
borders.

Extrack Carr
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GETTING ON-LINE HELP

This guide only discusses the major features of Cardiris. However, Cardiris is
a comprehensive, fully featured business card organizer that has many extra
features which we did not discuss here. You are recommended to consult the on-
line help system to obtain more information on its numerous capabilities.
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B Cardiris Help

5E A

Hide Home

Contents ]Igdex 1 §earch1

Welcome to the Cardiris help
S Introducing Cardiris

@ Processing Business Cards
How ta,..?

Reference Information

@ Product Options

Product Registration

Product Support

W= [L.R.IS.

Optiong

Print

Welcome to Cardiris™ Help...

s Use on-line help to learn more about Cardiris.
o Quickly find answers to questions.

e Connectto the I.R.I1.5. web site for latest tips and
product updates,

©2003 Copyright LR.I.S, All rights reserved




	Introducing Cardiris
	Installing the software
	System requirements

	View modes
	Album view
	Card view

	Recognizing business cards
	Scanning
	Segmenting scanned images

	Data fields
	Card styles
	Recognition
	Drag-and-drop editing
	Card status

	Displaying the contacts
	Limiting the display to cards of a certain status
	Limiting the display to cards that start with a certain letter
	Searching contacts

	Exporting and synchronizing contacts
	Contacting I.R.I.S.
	Visiting the I.R.I.S. web site
	Cardiris on the Internet



